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Introduction 
 

This guide does not reference any Engineering Design Standards. Refer to the ITD Roadway Design 
Manual, AASHTO's A Policy of Geometric Design for Highways and Street (Greenbook) and other 
appropriate publications for design standard guidance. 
 
The ITD Computer Aided Drafting and Design Standards and Procedures Guide (CADD Standards Guide) is 
intended to outline the use of Idaho Transportation Department ‘s (ITD) corporate workspace and Bentley 
System’s ProjectWise and OpenRoads software packages, as well as other tools and procedures developed 
internally.  
Following these standards will help to unify the appearance of drawings included in plan sets and facilitate 
the exchange of information between ITD districts and sections as well as consultants or contractors 
working on ITD projects. The ITD CADD Standards Guide will address issues such as software, standards, 
tools, and procedures which will aid in the efficiency and consistent production of ITD plan sets. This guide 
and the electronic resource files contained in the ITD workspace are intended to be used by both ITD 
internal design sections and the consulting firms doing business with ITD utilizing ITD’s ProjectWise 
managed workspace. 
With the use of ITD’s ProjectWise Managed workspace and CADD Standards guide ITD has created a 
complete electronic project delivery and archival system beginning with Planning and continuing through 
Construction and Maintenance. The combination of software, workspace, and workflows will allow all 
users to work together in the most efficient and productive environment possible. 
 

ITD’s deployed software Versions: 
ProjectWise Explorer:   10.0.3.453 
OpenRoads Designer 2023:            23.00.01.11
 

Useful ProjectWise Links: 
 
ITD Knowledge Library 
 
Standard Drawings 
 
Borders 
 
OpenRoads Seed Files 
 
Plotting Resources 
 

pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\ITD Knowledge Library
pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\Standard Drawings
pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\Borders
pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Workspace\ITD OpenRoads\Organization-Civil\ITD_Standards\Seed
pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Workspace\Plotting
pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\ITD Knowledge Library\OpenRoads\OR GUIDE Print Organizer.pdf


ITD Workspace Standards 
 

The ITD Corporate Workspace is a custom environment designed to facilitate CADD productivity and 
direct the user to ITD specific standards, workflows, and procedures. The ITD Workspace is a set of 
ProjectWise csb/cfg files, OpenRoads Designer resource files, documentation, and customized tools, 
designed to work together to allow for development of a standardized project plan sets.  
The ITD csb and cfg files define locations within ProjectWise where OpenRoads Designer will find ITD 
specific resources. Along with the csb/cfg files, custom tools, tasks, and utilities needed to perform 
design and drafting functions have also been created and made available to the users within the 
workspace. These tools have been included to save the user’s time and enable them to be consistent 
between projects. 
For all users, ITD employees and consultants, installation of the workspace is not required if the 
ProjectWise Managed Workspace is utilized. 
All CADD software upgrades and the workspace maintenance will be maintained by HQ 
CADD/ProjectWise support team with guidance being provided by the Technology User Group (TUG), a 
group of designated power users from all pertinent groups within ITD. The use of ProjectWise and its 
managed workspace will ensure that all ITD and consultant users are using the same and most up to 
date workspace available. 
 
If Consultants wish to download and use ITD’s workspace outside of ITD’s ProjectWise Environment (not 

recommended as updates are performed regularly) they can contact ITD CADD/ProjectWise support team and 

request the needed files or download the workspace folder from ProjectWise.  If this is done it is to be known 

that from said day of download it is possible the workspace files will not be up to date and ITD will not support 

issues that may arise from a user’s custom workspace.   

 

Drafting Standards and Resource Files 
 
ITD standard resource files consist of cell libraries, seed files, level libraries, text and linestyle design 
libraries, and other CADD information necessary to create project plan sets that conform to ITD 
standards.  Adherence to these standards ensures consistent plan set appearance and accuracy. 
 

Seed Files 
 
Seed files are the basis for all ITD OpenRoads Design files. Seed files are templates in which parameters 
have been set for the ITD standards. The seed files define the working units, global origin of the 
coordinate system, resolution, and whether the file is a 2D or 3D file. Seed files for both 2D and 3D are 
available in the workspace and should always be used when creating a new design file.  All ITD design 
disciplines use the ITD “Standard” seed files except for the Bridge Section.  ITD’s Bridge Section has its 
own “Bridge” 2D and 3D files. 
 

Working Units 
 
Working units settings are used to control units of measurement for design files.  ITD requires that all 
design projects be completed in imperial or “English” units; therefore, ITD seed files have been 



developed for imperial units only.  ITD working units are based on the U.S. Survey Foot for master units 
and US Survey Inches for the sub-unit. 
 

Units Resolution 
 
The resolution for all ITD seed files, including Bridge seed files, has been set to 12000 units per US 
Survey Foot and this resolution setting should not be changed. This setting affects the size of the 
elements within an OpenRoads file and if changed will incorrectly scale all existing elements within the 
file. 
 

Coordinate and Angular Readouts 
 
The coordinate system determines the accuracy and format of the design file. ITD uses the Idaho State 
Plane Coordinate System on all roadway design projects and the standard seed files will accommodate 
this coordinate system. 
The Coordinates set the format and accuracy of the design file based on the working units. The degree 
of accuracy is based on the number of decimal places or, for Bridge, the fraction selected.   ITD Standard 
seed files are set to a coordinate readout of Master Units with an accuracy of four decimal places. The 
Bridge seed files are set to a coordinate readout of Master Units and accuracy of 1/32. 
 
The Angle settings control the format, mode, or accuracy of the design file angular readout. ITD 
Standard 2D and 3D seed files are set with the angular format of Degrees/Minutes/Seconds with an 
accuracy of 0. The Bridge seed files set the angular format to Degrees/Minutes/Seconds with an 
accuracy of 0 and the mode to “Bearing”. 
 

Global Origin 
 
The file global origin is a point within the design plane used as a base point for the placement of graphics 
elements.  ITD’s 2D and 3D files use the default OpenRoads global origin which is located in the center of 
the design plane. 
 

2D or 3D Seed Files 
 
The ITD Standards contains both 2D and 3D seed files and both are available for use when creating a 
new file.  Both files have the same settings applied to them with the addition of the Z value in the 3D 
file. All design model files should be created using the 3D seed file.  All other .dgn files should be created 
from the 2D seed file and referenced to the 3D model files. 
 

Cell Libraries 
 
The ITD Workspace contains many cell libraries, each of which is made up of discipline specific data and 
is intended to be accessed and used by designers of all sections. Cell libraries will be listed when the cell 
placement tool is activated within the software. 
 



 

Design File Level Libraries 
 
Design File Level Libraries (DGNLIB) and corresponding specialty section filters have been developed to 
allow users to seamlessly work across disciplines and level duplication has been avoided wherever 
possible. The DGNLIB files are assigned to the seed files and available when a new file is created.   The 
creation of new levels and changes to the existing levels has been locked within the ITD Workspace in 
order to maintain the “ByLevel” symbology that allows data to inherit attributes for color, linestyle and 
weight from the level it is placed on. ByLevel symbology is the default for all level libraries and is the 
required ITD standard. ITD levels are named with the following format: Type_Use_Description, for 
example, DES_ROADWAY_Aggregate-for-Base. 
 
Type or Use Designators: 

 
ALG – Alignment 
ANNO - Annotation 
BRDG – Bridge 
CONST – Construction 
DES – Design 
ENV – Environmental 
GEN – General 
HYDR – Hydraulics 
LAND – Landscape 
MATL – Materials 
ROW – Right of Way 
STD – Standard Drawing 
STRC – Structure 
SURV – Survey 
TOPO – Topography 
TRAF – Traffic 
TYP - Typical 
UTIL – Utility 
VISU - Visualization 

 

  



Level Filters 
 
Filters have been created for each of the ITD discipline specific level libraries to allow users too quickly 
and efficiently place elements on the appropriate levels and to turn levels on or off. 

 
 

Color Table 
 
The standard color table file, ITD.tbl, is attached by default to all ITD seed files. The colors within the 
table correspond to the By Level color symbology specified in the level libraries. Specific colors are 
assigned to ensure consistency and to enable users to easily identify data. Colors are defined by a 
number and OpenRoads reads this color table to determine the correct color to display. 
 

Line Weights 
 
Line weights in OpenRoads are defined by designating the thickness of the line used when plotting an 
element.  ITD uses line weights 0-4 on plan sets. These weights correspond to the ByLevel weight 
assignments within the level libraries. 
 

Line Styles 
 
A custom line styles library has been developed for use within ITD. The line styles are contained within 
the workspace in an OpenRoads resource file called ITD_Linestyles.dgnlib.  These lines styles correspond 
to ByLevel line style assignments within the level libraries. 
 



Annotation 
 
ITD has developed several font resources available in the ITD workspace and they are attached to the 
design file by configuration variables. The standard Font for plan sheet text is “Engineering Vert Bold”. 
ITD standard annotation text styles and dimension styles are contained in DGNLIB files. These libraries 
contain predefined text and dimension settings for several different sizes of text.  These standard text 
styles have been defined to ensure consistent legibility on all plan sheets. When a user selects a text 
style, the height, width, line spacing, justification and font is set automatically so no adjustments are 
needed.  The desired style must be picked from the drop-down menu before placing text as the default 
style attached to all ITD Seed files is “No Style”.  If Italics or Underline is desired, it can be selected 
through the OpenRoads Text Editor. 
 
ITD text style names include Size_Font_Justification Position, for example 0067_Eng Vert Bold_Lt Bot, 
some are followed by the word (Masked) which clips background elements around the text. Text sizes 
refer to the size of the text when plotted, not the text size in the OpenRoads file. The text size in the 
OpenRoads file is dependent upon the intended plot scale and the annotation scale. 
 
Maintaining the minimum letter height and letter stroke width is very important so that information 
does not disappear or become illegible when plan sheets are photocopied or reduced. 
The standard text style to be used for general purpose annotation is 0067_Engr Vert Bold_Ctr Ctr. There 
are several text styles available; however, these sizes are normally only used as titles or on 
presentations and exhibits. 
 
The ITD_Text Favorites_Text Styles_Dimension Styles.dgnlib file contains standard dimension styles for 
Bridge, Traffic and Design drawings. 
 

Annotation Scale 
 
The annotation scale is used for defining the scale of the cells, text, custom line styles, and dimensioning 
in both sheet files and model files.  Only custom linestyles are affected by this scale factor, native 
OpenRoads line codes are not. By default, the annotation scale lock is turned on.  The default drawing 
scale setting is 1:40. If a different scaled drawing is desired, the user must edit the drawing scale in the 
model properties or under the “Settings” option on the main menu bar.  Annotation that has been 
placed by OpenRoads is not affected by the model drawing scale. OpenRoads text size is controlled by 
the global scale factor in OpenRoads.  If OpenRoads text is not displayed the right size or if a different 
scale is required, the annotation should be redisplayed with OpenRoads using the correct global scale 
factor. 
 

  



Drawing Notes 
 
Drawing notes should be a combination of uppercase and lowercase lettering. Uppercase lettering is 
desirable for all drawing titles. 
Notes and lettering on plan sheets should be readable from either the bottom or right-hand edge of the 
sheet.  Vertical lettering, approximately perpendicular to the bottom of the sheet, should be upright in 
relation to the right-hand edge of the sheet.  All other lettering should be upright in relation to the 
bottom of the sheet. 
 
Callouts on the plan sheets that refer to notes or further information shall use the following standards: 
 

 

Modeling Standards and Resources Files 
 

Workspace settings are controlled by a number of dgnlib’s that apply various settings automatically. All 

settings are applied in Element Templates and/or Feature Definitions, below is a brief description of 

both. 

Element Templates  
Element Templates are used to apply CADD standards and define symbology. Element templates refer to 

ITD’s “By Level” symbology and are set up to be the base symbology for Feature definitions. 

Feature Definitions 
Feature Definitions are used to control symbology, annotation, and various other properties that are 

applied to the geometric elements. 

The feature definitions are used to: 
Define what the geometric elements are. What is being modeled such as curb, centerline, edge 
of pavement, etc. 
Control symbology in various views, including capability to define differing symbology in plan, 
profile, and 3D spaces 
Define terrain modeling attributes (spot, break line, void, etc.) 
Define surface display characteristics 
 



 
Below are brief descriptions of the common output and input files that can be used in OpenRoads. This 
is a limited list of file types and just touches on the capabilities of OpenRoads input and output files. 
 

Digital Terrain Models (*.dtm) 
Digital Terrain Models are mathematical representations of the surface of the earth. OpenRoads uses 

DTM data to produce contours, display the existing and proposed ground lines in profile and cross 

section grids and in the calculation of cut and fill quantities.  DTMs are created with a combination of 

surface points identified as spot points, break lines, contour lines or other point types used to define the 

surface. 

Existing Ground Surface 

Existing ITD Digital Terrain Models represent existing ground conditions at the time that survey 

data was collected. Existing DTMs may be assembled from traditional survey, LiDAR mapping, 

aerial ortho-photography, or a combination of those methods. 

Proposed Ground Surface 

Proposed ITD Digital Terrain Models represent the project design surface as generated by 

OpenRoads using the horizontal alignments, vertical alignments, templates, and roadway 

definitions created by the designer. Most projects will contain multiple DTMs that define the 

changes to the existing ground surface for various portions of the project, such as the mainline, 

ramps or detours. 

Geometry Project Files (*.alg) 
ITD Geometry Project files contain horizontal alignment, vertical alignment, and superelevation 

information. The Existing Geometry Project contains the centerline of survey as acquired by the Survey 

department. Proposed Geometry files contain geometry relating to proposed horizontal and vertical 

data. The proposed geometry file will contain all alignments for the roadway design including ramps, 

detours, cross streets and the associated vertical profiles. 

Important note: There are a number of settings in the alignment file that must be evaluated by the design 

engineer.  Many of the settings have been addressed in the ITD configuration; however, care must be taken to 

assign proper values for the modeling of the design surface as required by the project. 

Template Library (*.itl) 
The Template Library contains templates, template components and end conditions, transition control 

names, and other data used to model the proposed roadway surface. The standard ITD Template Library 

file contains standard templates and tables that can be copied and modified for each specific project 

requirement. If the .itl file is stored outside the dgn file it should be placed in the Project 

Development\Project_Resources\ folder.  The naming convention for Template Library consists of the 

project key number with the .itl file extension. 

XML Data File (*.xml) 
This file contains the geometry project cogo points and surface data that is used to create XML reports 

and can be imported to a dtm.  When the xml file is generated by the OpenRoads XML Report tool, the 

file is placed in a temporary directory.  If the xml file is to be saved for later formatting, the file should 

be placed in the Project_Development\Civil_Data folder in the project directory. 



Styles Sheets (*.xsl) 
OpenRoads reports are the result of xml data formatted by an .xsl or Style Sheet file. These files specify 

what information is used from the XML Data files that are output by OpenRoads and how the 

information will be formatted and displayed to create an OpenRoads report.  Several ITD standard style 

sheets have been defined and are stored in the:  Workspace\ITD OpenRoads\Organization-

Civil\ITD_Standards\Reports\ 

Project Directory Structure 
 
An ITD Corporate folder structure has been developed to store all project related data from planning 
through maintenance. This guide is concerned only with folders under the Project_Development 
directory and to the resource files and information related to the ITD Workspace. The 
Project_Development folder structure is integrated with the ProjectWise .csb and OpenRoads 
configuration files so that the user will not have to navigate to find files. OpenRoads will find the 
necessary files to ensure the ITD configuration runs correctly. 
 
This directory structure, along with a standard CADD file naming convention, has been created to enable 
efficient management of all files within an ITD project. This will aid in the exchange of data between ITD 
sections and ensure consistent and reliable data retrieval by all members of a project team.  This 
document will only address that portion of the file structure that pertains to the CADD design process. 
The ITD “Projects” Directory has been designed so that the top-level directory for each project is 
designated by the 5-digit project Key Number prefaced by the letters “prj”. Under this directory the user 
will find sub-directories where all project information will be created and stored using ITD’s standard file 
naming convention.  Below the project directory you will find subdirectories for each of ITD’s specialty 
sections. Under each specialty section directory is a sub-directory structure unique to that section. All 
folders have a Description of the documents that should reside within. 
 

 

 



The project directories will be created by the Districts ProjectWise Coordinators/BASS Team or HQ 

support after the projects key # has been assigned. If a project directory is not created at the time work 

begins please contact the Districts ProjectWise Coordinator/BASS Team or HQ CADD/ProjectWise 

support team. 

This directory structure is the foundation of a project lifecycle that includes electronic plan review, 

bidding, inspection, machine control and maintenance. Following this standard directory structure 

without revision will ensure the accurate sharing of information between sections within the 

department as well as with consultants and contractors. 

Project Directory Security 
Security and access permissions are controlled ProjectWise Access Lists that are assigned to each folder 

by the Project Templates within ProjectWise. Each district has determined the level of security needed 

by members of their design teams and arrange for them to be included in the appropriate ProjectWise 

access lists. 

Consultants and/or Contractors will need to contact their ITD Project Manager or equivalent to request 

Project permissions. 

These requests should then be sent to the BASS Team or HQ CADD/ProjectWise support Team from the 

ITD Contact. 

The Request should Include: 
Company Name: 
Users Email Address: 
Project Key#: ProjectWise Link to Key# 
Folders Requested: (A standard request of Project Development Folders or Constructions Folders is 
sufficient, but permissions can be as granular as needed)      
 

CADD File Naming Conventions 
 

The ITD design process requires that CADD drawings be created in multiple design files depending on 

their discipline.  Over the life of a design project, many of the specialty sections will create CADD data in 

design files that need to be referenced together to produce a final plan set. These design files need 

standard, unique, names that allow the CADD user to easily identify the specialty section responsible for 

the file and the type of design data the file contains. 

When used consistently, ITD’s CADD File Naming Convention will allow for easy, dependable, archiving 

and retrieval of data for the complete lifecycle of a project.  All ITD CADD drawings should follow this 

standardized naming convention so that project data can easily be identified and accessed by all 

sections.  



Design File Types and Standard Naming Convention 
 

Four primary design file types have been adopted with the new CADD standard naming convention. 

Border Files 
Border files are OpenRoads design files that contain a border template and annotation that is common 

to all pages within the plan set. This border file is referenced to the sheet files.  Border files are stored 

with a .dgn file extension and should be copied into the project directory 

(prj#####\Project_Development\Project_Resources), from the following ProjectWise location:  

pw:\\Itd-pw.bentley.com:Itd-pw-01/Documents/Standards/Borders/ 

 

Sheet Files 
Sheet files are OpenRoads design files that contain annotation and graphics that are specific to one page 

in a plan set.  Model files and border files are referenced to the sheet file to create a plan set drawing 

ready for plotting. Sheet files are created by the designer or by the OpenRoads “Named Boundary Tool” 

and are stored in the project directory (prj12345\Project_Development\Plan Sheets) with a .dgn file 

extension. 

Sheet files will be named using a project key number prefix, four-letter sheet designator code, a three-

digit sheet number and an alpha character used only if the sheet is being inserted into an existing plan 

set.  The three primary components will be separated by a space in the file name, as shown below: 

 

 

There will be slight differences in the naming convention for Bridge files. 

 

* The spaces in the naming convention for the Bridge sheets indicate where a two- character code will be inserted 

to denote the location of the bridge in the roadway project. 

 

  

pw://Itd-pw.bentley.com:Itd-pw-01/Documents/Standards/Borders/


Model Files 
Model files are OpenRoads design files that contain design graphics representing existing or proposed 

features and conditions of the project. These files are referenced to the sheet files. Models could be 

referenced to a single sheet file multiple times or may be referenced to multiple sheet files. Model files 

are created by the designer and stored in the appropriate section or discipline’s directory in the 

(prj12345\Project_Development) directory with the standard OpenRoads .dgn file extension. 

 

The naming conventions that are presented below are intended for model design files. Names will 

include a project key number prefix, a file type designator code, three-digit sequence number, and alpha 

character used only for design files that are inserted into the sheet sequence at a later time. The three 

primary components of the name will be separated by space when the design file is created, as shown in 

the example below: 

 

 

File Types and Designators 
 

File Type Discipline File Type Designator 
Border All bord 
Bridge Details Bridge bdtl 
Bridge Materials Bridge brmt 
Bridge Summary Bridge bsum 
Design Roadway desn 
Details and Diagrams All detl 
District Traffic Signal Traffic dtsg 
Erosion Control Roadway eros 
Foundation Investigation Materials finv 
HQ Signal Traffic hqsg 
Hydraulics Roadway hydr 
Illumination Traffic illm 
Illumination Materials Traffic Ilmt 
Intersection Controller Schematics Traffic Icsc 
Landscape Roadway land 
Minor Structures Roadway mstr 
Pipe Culvert Summary Roadway pcsm 
Plan All plan 
Plan and Profile Roadway plpr 
Profile Roadway prof 
Project Clearance Summary Roadway pcsm 



Record of Survey Survey rosv 
Right-of-Way Right-of-Way row 
Right-of-Way Plans Right-of-Way rowp 
Roadway Details Roadway rdtl 
Roadway Material Quantities Roadway rwmt 
Roadway Summary Roadway rsum 
Signal Controller Schematics Traffic scsc 
Signals Traffic sgnl 
Signing Traffic sign 
Pavement Markings Traffic pvmk 
Soils Profile Materials soil 
Source Materials plat 
Special Drawings All spec 
Special Map All smap 
State Maintenance Group Maintenance smgr 
Title All titl 
Topography Survey topo 
Total Ownership Map All omap 
Traffic Control Plan Traffic trcp 
Traffic Detail Traffic tdtl 
Typical Sections All typi 
Utility Sheets Roadway util 
Vicinity Map All vmap 
Work zone Traffic Control Traffic traf 
X-Section Roadway xsec 

 

Standard Drawing files 
Standard drawings are design files that contain completed design standards that are used repetitively in 

plan sets and have their own special border sheets. These drawings are inserted, without modification, 

directly into the plan sets.  Standard drawings are stored on the ITD web page (Standard Drawings) in 

PDF format and in OpenRoads format. Files are also located within ProjectWise at this location: 

pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\Standard Drawings\ 

 

OpenRoads Data File Types and Standard Naming Convention 
 

Geometry Alignment files 
The primary working geometry alignment file for a roadway project will be named using the project key 

number and stored in the prj12345\Project_Development\Civil_Data directory, for example: 

12345.alg 

This working file may contain many horizontal alignments and working variations of the project 

geometry. The alignment description should include the date, the route number and a brief explanation 

of the purpose.  For example: 

https://apps.itd.idaho.gov/apps/StandardDrawings/StandardDrawings.htm
pw://Itd-pw.bentley.com:Itd-pw-01/Documents/Standards/Standard&space;Drawings/


3/17/08 I-15 expansion 

Horizontal alignments are generally used to represent geometry of the centerline of both existing and 

proposed routes.  Horizontal alignment will be named using the route number or name. For example: 

 

When alternate horizontal geometry alignments become necessary during the course of a roadway 

project, their names will consist of the name of the route, a space, the letters “alt” to designate that the 

file contains alternate geometry and a sequencing number: 

 

For final horizontal alignments simply add the word “final” to the name to indicate that 
the horizontal alignment represents the final vertical geometry as shown below: 
 

US-20 Final   Final Horizontal Alignment 

Vertical alignments are children of the horizontal alignment. Each parent alignment may have several 

“children” and their names only need to designate the difference between versions or revisions.  

Vertical alignments will be named “alt” with a sequencing number to designate different alternates as 

shown below: 

 

For final vertical alignments simply use the word “final” in the name to indicate that the 
vertical alignment represents the final vertical geometry as shown below: 
 

 

Alignments for streets or cross streets will include the street name. Alternate alignments for streets 
will include the “alt” designation and final alignments for streets will include “final” in their names 
as shown below: 

 



Alignments for ramps will include the name of the street to which the ramp will connect a space, and a 

two-letter code representing the terminal points of the ramp. 

Alternate alignments for ramps will include an “alt” designation and final alignments for streets will 

include “final” in their names as shown below: 

 

 

Surface files 
Original ground surface names will include the project key number, the descriptive name “orig” to 

indicate that the surface represents original ground and a 3-digit number to indicate the surface 

sequence.  Original ground surface files will be stored in the prj12345\Project_Development\Location 

directory. 

 

The description will include the date, the route number and a brief description of the surface, as shown 

below: 

3/17/03 I-15 original ground surface 

The surface files that are created during the design process will also use this convention with a 

descriptive name indicating the design layer the surface represents and a 3-digit number to indicate the 

surface sequence. These files will be stored in the prj12345\Project_Development\Civil_Data directory. 

 

The surface description will include the date, the route number, and a brief explanation of the surface, 

as shown in the example below. 

3/17/03 I-15 mainline subgrade surface 



Template Libraries 
Template library names will use the project key number and will be stored in the 

prj12345\Project_Development\Civil_Data directory.  If alternate template libraries are created, the 

names will consist of the project key number the letters “alt” to designate that the file contains 

alternate templates and a sequencing number. The final template libraries will include “_final” in their 

names as shown below: 

 

 

The template library description will include the date, the route number, and a brief explanation of the 

purpose of the template library. For example: 

3/17/03 I-15 typical sections 

Template names will include descriptive information, such as the route number, the number of lanes 

that the template will model and a sequencing number to differentiate between multiple templates.  

For example, a two-lane template for a section of highway on Idaho State Highway 21 could be named 

as follows: 

 

The template description will include the date, route number, short indication of the template’s purpose 

and the station range in which the template will be used, as shown in the example below: 

3/17/03 SH-95 centerline two-lane from 125+50 to 235+70 

Corridor Definitions 
Corridors files will be named using the route number, as shown below, and stored in the 

prj12345\Project_Development\Design directory. If alternate Corridor files are created, the names will 

consist of the letter’s “alt”, to designate that the file contains alternate corridors, and a sequencing 

number. The final corridor definition will include “final” in their names as shown below: 



 

The corridor file description will include the date, the route number, and a brief explanation of the 

corridor.  For example: 

3/17/03 SH-24 corridor definitions 

Corridor names for the roadway project will include the route number and a sequencing number.  For 

example, a roadway definition for a section of highway on State Highway 24 will be named as follows: 

 

The Corridor file description will include the date, route, street or location and station range of the 

corridor being modeled.  For example: 

3/17/03 SH-95 Main Line from 1500+00 to 2700+00 
or 

3/17/03 Broadway from 240+00 to 290+00 
 
 

Project Plan Sets 
This chapter is concerned with the CADD standards aspects of preparing an ITD plan set. 

All plan sheets should be developed using ITD's CADD Standards and the ITD Corporate Workspace.  All 

plan sets will have English units throughout and shall be in a format compatible with the ITD CADD 

system. 

Final plan sheets submitted for advertisement shall be properly endorsed by the engineer.  They shall be 

created in a pdf electronic format and/or on a durable medium such as mylar or other archivable paper 

to preserve the drawings for archival purposes. 

Some necessary details for preparing project plan sheets may not be covered in these procedures. If 

questions arise on the amount of detail or appropriate format, other similar project plans should be 

reviewed for example or the Roadway Design section should be contacted. Variations to these 

instructions require approval from Roadway Design. 

Appendix 1 – Example Plan Sheets 



The following information explains typical plan preparations and organization for preparing project plan 

sheets for the Idaho Transportation Department. 

Plan Sheet Size 
ITD prepares plan sheets for design and construction in two sizes, Standard plan sheet which is 11” x 

17”; and Maintenance Project sheet which is 8 ½” x 11”.  In addition to the plan sheets, the Bridge 

section requires a 22”x34” mylar sheet for their records and the Location section produces a Record of 

Survey which is an 18”x27” transparency. The drawing details should not be crowded on the plan sheet 

and the text size should conform to ITD standards. 

Plan Sheet Scales 
The following plan sheet scales shall be used on all drawings for the Idaho Transportation Department: 

Roadway drawings  
1”=10’ 

1”=20’ 

1”=40’ 

1”=100’ 

1”=200’ 

1”=400’ 

Full Size 1=1 

Traffic drawings 
1” = 100’ ----- Minimum scale for pavement markings plan sheets without transitions or special details. 

1” = 40’ ------ Preferred scale for pavement markings plan sheets with transitions or special details. 

1” = 40’ ------ Scale for traffic signal intersection plans. 

 

Bridge drawings 
1”=1’ 

1”=5’ 

1”=10’ 

1”=20’ 

1”=30’ 

1”=40’ 

1”=50’ 

1”=60’ 



1”=100’ 

3/32”=1’ 

1/8”=1’ 

3/16”=1’ 

1/4”=1’ 

3/8”=1’ 

1/2”=1’ 

3/4”=1’ 

1 1/2”=1’ 

3”=1’ 

  

Right of Way Drawings 
 1”=20’ Urban 

 1”=40’ Rural 

Plan Sheet Title Block 
All plan sheets shall use the ITD title block designed for that specific sheet. The title block shall have all 

the necessary information shown in its appropriate place. Changes to the title block may be made with 

the approval of the Roadway Design section. The following describes the basic information in a standard 

title block. 

Revisions 
The revisions section is only for changes to the plan sheets after they have been stamped and endorsed 

by the engineer. Each change should be marked with a triangle and numbered successively.  In the 

revisions box the triangle shape should be marked with the corresponding number of the plan sheet 

change and a date, the initials of the person making the revisions, and a description of the revision 

entered in the appropriate place. Each different change should be entered on a new line.  Entries in this 

box should primarily be made by the Roadway Design section. 

Preparer's Names 
Enter the names of the designer, the person who checks the design, the detailer, and the person who 

checks the drawing, whenever appropriate. 

CADD File Name 
File Name:  A standard electronic file naming convention is used by ITD for the naming of plan sheets to 

be retained and archived. 



Date 
Enter the date the drawing is completed, which is usually when the last corrections are made for Final 

Design or Contract Advertising submittal. 

Section Name 
The section name box is directly below the ITD name and seal and is for the area section name, or the 

consultant may place their business name within this box. Appropriate names would include the district 

and section, such as “District 6 Design” or “Headquarters Traffic Section.” 

Federal-Aid Project Number 
On the title sheet only, for federal-aid projects it may be necessary to show two or more project 

numbers when right of way and construction are handled under separate project numbers. Show the 

construction project number only on all other sheets. 

If it is a state project, show the project number in this box. 

Sheet Title, Project Name, and Description Box 
A sheet title consisting of the type of sheet it is should be shown for each sheet. The names should 

generally coincide with those shown in the index. 

The large box below should generally have the project name but may include additional information 

such as sheet station limits, structure numbers, intersection names, and other brief identifying 

descriptions. 

County, Key Number, Sheet Number 
The top box is the system of measurement, in most cases ENGLISH.  The second box should show the 

county or counties in which the project is located.  The third box should show the project key number. 

The bottom box is for sheet numbering. 

Engineer's Endorsement Space 
The endorsement by the engineer must be on a standard size plan sheet. Full size electronic 

representations of the engineer's stamp shall be used on standard size plan sheets. 

Order of Plan Sheets 
Plan sheets shall be assembled in the following order. 

Roadway Group 
Title Sheet 

Standard Drawing Index 

Vicinity Sketch 

Total Ownership Map 

Plan sheet index showing the area covered by each plan sheet on the Total Ownership Special Maps 

Project Clearance Summary 



Typical Sections Summaries 

Roadway Summary 

Bridge Summary 

Pipe Culvert, Pipe Siphon, Irrigation Pipe, Sewer Pipe Summaries 

Pipe Under Drain Summary 

Plan and Profile Sheets 

Special Drawing Group 

Sediment and Erosion Control 

Minor Structures Drawings 

Drainage Plans 

Paving, Concrete Joint, Approach Slab Details 

Roadside Development and Landscaping Plans 

Bike Lanes and Pedestrian Path Plans 

Source Plat and Reclamation Plans 

 

Traffic Group 
Illumination Materials List 

Illumination Plans 

Traffic Signalization Materials List 

Traffic Signal Plans 

Railroad Signal and Crossings 

Signing Erection Specifications 

Signing Plans 

Pavement Marking 

Delineation and Raised Channelization 

Traffic Control Plans 

Utility Group 
Optional separate numbering 



Right of Way Group 
Optional separate numbering 

Bridge Drawings 
Optional separate numbering 

State Maintenance Group 
Optional separate numbering 

Standard Drawings 

 

Detail sheets shall be located directly after the plan sheets to which they are related. 

 

Assembling Sheets Files 
Projects plan sets consist of both planimetric sheets, which contain plan and/or profile views of a design 

model and informational sheets that contain text-only information. 

Project plan sheet files should be made up of design model files drawn in real world coordinates and 

attached to the sheet files as reference files. Informational sheets need not contain design graphics, but 

may only contain text such as general notes, or other instructions or details.  It is recommended that 

text-only information be placed within the sheet file. If the text is in a table format the text and linework 

should be placed on their appropriate levels.  In the case of a typical section or detail drawing it is 

suggested that the linework be drawn in a model file on the appropriate drafting levels and the text and 

dimensioning be placed in the sheet file. 

Some types of graphic information that does not reside in real world coordinates such as a scaled detail 

of an irrigation structure, could be placed in either a model file or a sheet file. 

Right of way or Utility plans are put together in the same manner as Roadway plan sheets, according to 

the guidelines of the ROW or Utility section guides, by referencing a combination of existing design and 

plan sheet files to specific Right-of-Way or Utility files to show the necessary topo, survey and roadway 

details required to make up a detailed set of plans for the use of the Right of Way and Utility sections in 

their work. 

The ITD workspace is setup to use the Named Boundary tool for creating Plan, Profile, and Cross 

Sections sheets in varying scales per ITD standards. This tool automates the attachment of references 

files and rotates and clips the file to align with the profile and sheet border.   

The Place Named Boundary tool uses the designated OpenRoads horizontal alignment to determine the 

center of the plan view window. The clipping boundaries and match line locations are defined by the 

user.   

Plan sheets for projects that do not contain OpenRoads alignments will need to be set up by individually 

attaching, rotating, and clipping the required reference files to the sheet file. 



Plotting 
 

ITD uses the standard print and print organizer tools available in the OpenRoads software. ITD has 

created support files within the Workspace to help streamline the printing process. 

Appendix 2 – ITD Printing Guide 
 

Design Scripts 
ITD design scripts are applied during plotting to control pen widths, colors, and specially colored plots 

such as right-of-way plan sheets. These design scripts recognize ITD’s named levels and elements placed 

on incorrect levels may not plot as desired. Standard design scripts have been created for black and 

white plotting, full color plotting, and for black and white plotting with colored right-of-way or utility 

details in each acceptable sheet size. 

Roadway plans should be plotted using the Halfsize BW.pen design script. 

Traffic plans should be plotted using the Halfsize BW Signs.pen design script which plots everything on 

levels TRAF_SIGN_Annotation, TRAF_SIGN_Existing, TRAF_SIGN_Portable, TRAF_SIGN_Post, and 

TRAF_SIGN_Proposed WITHOUT fill on the signs. 

ROW plans should be plotted using the Halfsize ROW.pen design script which plots everything on levels 

ROW_Parcel, ROW_Easement-Hatch, and ROW_Total-Ownership- Boundary in color with a 

transparency of 80% and everything else black. 

Utility plans should be plotted using the Halfsize Utility.pen design script which plots everything on 

levels beginning with UTIL_* , TOPO_ELEC_*,TOPO_GAS_*,TOPO_LIGHTING_*,TOPO_OIL_* 

TOPO_SAN_*,TOPO_STORM_*,TOPO_TELE_* , TOPO_TV_*, TOPO_WTRUTIL_* and 

TRAF_ILLUMINATION_* in color with a transparency of 80% and everything else black. 

Print Styles 
 

The ITD Workspace has various Print Styles setup to set the print settings in a print organizer file(pset). 

These print styles are named to match the type of sheets you are trying to create and allow for settings 

to be applied to multiple sheet files at a time. see below. 

 



Acceptable Plot Sizes 
The standard ITD plot size is 11" x 17" which is the default setting. Other plot size settings are available, 

such as 8 ½”x11” for Maintenance type jobs and other varying sizes for larger size exhibits or 

presentations. 

 

OpenRoads Designer Customized Ribbon 
 

ITD has customized the OpenRoads toolbar and Ribbon to streamline and simplify some often-used 

commands and processes. 

The ITD Shortcuts portion of the ORD Ribbon appears under the Home tab under all workflows available. 

 

 

 

ITD Shorcuts Tools and links 

 

Update Titleblock-Updates the ITD Titleblock Cell from the ProjectWise Attributes 

Appendix 2 -  Titleblock instructions are located on pages 10-12  

SignCAD Load- Loads SignCAD if the software is installed on your pc 

SharePoint-Is a Link to ITD’s internal SharePoint Site for OpenRoads Designer (CADD) 

IPLAN-Link to ITD’s GIS site for the creation of Vicinity maps for Title Sheets. 

Appendix 3 -ITD Vicinity Map Instructions 

 



 

ITD Workflow Customization 
 

ITD has developed some simplified workflows for Drafting and Modeling. These workflows reduce the 

tools on the ribbon and focuses the tools to common commands most often used. 

ITD Drafting Tools workflow   

 

 

 

ITD Modeling and Drafting 

 

 

Worksets and the Managed Workspace 
 

ITD’s ProjectWise Managed Workspace is configured for the use of Worksets. Worksets are project level 

standards that may be added to ITD’s workspace if desired. The operation of the Workset is controlled 

by the prj(projkey#).cfg found at the root of the Workset folder, the name of this cfg can NOT be 

changed and remain functional, it is also not recommended to modify the content of this cfg file. 

Modification can be done in more advanced setups but is not recommended. Also, at the root of the 

Workset folder is the projects dgnws file, this file is created automatically and can NOT be renamed. 

These dgnlibs, .itl files, etc.  can be added under the Workset folder of the Project, 

prj12345\Project_Deveopment\Project_Resources\Workset\. By default, only three folders are created 

here as they are the most common project related files. 

 



Notice the description of the folder for proper file placement. See Workset template folders here: 

pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\Standards\Workset Folder Template\ 

 

The Dgnlib folder requires additional sub folders to function correctly and all files placed in the sub 

folders must be dgnlibs to be loaded. 

 

Copy the required folders from the Workset Template and paste them within the Workset folder in the 

project. 

Attention should be given to the folder Descriptions as explanation of use is spelled out there. One 

important note about Template libraries is that the project .itl file has to be named prj(projkey#).itl to 

load automatically. It can be loaded manually if more than one is used but will default to the correctly 

named .itl file. 

pw://Itd-pw.bentley.com:Itd-pw-01/Documents/Standards/Workset&space;Folder&space;Template/
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1. Creating a “Plot Set”   
 

A “Plot Set” is a group of drawings put together that you will eventually print, one or all.  You may want 

to create a paper copy or a pdf.  This will only cover drawings with an ITD Border attached.  

Open any drawing in MicroStation in ITD Workspace.  (If you are opening a drawing from ProjectWise 

you will be in ITD Workspace.)   

Go to “File” then down to “Print Organizer”.  You will get a tool box pop up like below.   

 

 
 

You are ready to add files.  You can either select “File>Add Files to Set”.  Or select the tool at the top. 

     (When hovering over it says “Add Files to Set”) 
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The next box pops up.  Select Add

 

In the next window, select any or all the plan sheets you would like to print. Order does not matter.  You 

can always add more later.  When done, select “OK”.   

Depending on your selection it may take a minute or two.  I picked 10 drawings, they all show below. 

  

Now we will select a Print Style name:  Select the spy glass.  The next window pops up.  Depending on 

what you are wanting to do, you will select the Print Style that you want.  I want to create a 11x17 plan 

set.  So I selected 11x17 BW.pdf. Select and then OK. 

“Spy Glass” 
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Then Select OK again on the original window.  Give it a few minutes to create your plot set. 

 

Now you can put your sheets in order.  The order of your drawings are especially important if you are 

using the cell and attributes that will number your pages automatically.  (See that section 3 for further 

directions.)  

On the Right select a drawing. Then use the tools     to either move it up one or move it 

to the top or bottom.  (Hover over tools to help to know what they do.) You can also remove a drawing 

from your plan set if needed.  Looks like I have 2 title sheets selected.  In the Right Box, Select any that 

does not belong and then select the red x to remove it.   

This is with window that 

comes up.  These are 

the Print Styles set up 

and are ready to use.   

(You can find more 

explanation on the 

Styles; ROW, TRAFFIC, 

and UTILITY in Section 4 

of this guide.)  
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NOTE: when creating a plan set and one of your pages to be included is already a pdf you will need to 

add a “Placeholder” page. Any misc. page drawing will work, I use a blank border. It is important to put it 

in the order where the pdf will be.  For example; if you have a signed Monument Sheet that is a pdf; add 

to your plot set any random drawing for a “Placeholder” page in the spot you want it accounted for.  

After you have created your plan set, you will have to use your Blue Beam to take out the “Placeholder” 

page and insert your signed monument page.  

Before moving too far along it is a good idea to save the plot set.  Once the plot set is saved, next time 

you are ready for printing, you will only need to open the plot set from any drawing and you will be 

ready to add more drawings or simply print.  

Right now your Plot Set is named “Untitled”.  See by the red arrow on the above screen print. Save by 

selecting the “Save” tool or File> Save As. You should recognize the next several windows that are 

common to the save process in ProjectWise.   I will be saving this plot set under my project key number 

and plan sheet folder. If you want to double check to see if it saved, the extension is .pset. You will want 

to remember this as it will be easy to open in the future for printing.  

Now my Plot Set is saved and named Preliminary Plan set. 
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2. Creating a Print  
In any drawing you can open any Plot Set:  File> Print Organizer, then select “Open” in the Print 

Organizer window. (Remember the file extension is .pset) 

You can print one or more or all documents in your set. If you want the entire set, you can select the 

folder on the top Left. 

 

Or you can make a selection and only print the selection. Make the selection on the Right side shown 

below. 

 

Select the “Print” Tool Icon. 

 

 

 

 

2 are 

selected 
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Producing a PDF 

As a default ITD Workspace is set up to create a pdf from your Plot Set as your first option. This is really 

the easiest and best option.  The pdf configuration file uses Bentley Drivers that read all the settings we 

have as standards.  After the pdf is created, you can use your pdf reader (Blue Beam) to print to any 

printer for a paper copy, or send the pdf for others to view/print. Choosing a printer here IS an option 

but does have more steps and may not print exactly as desired. 

 

Above is the window that will pop up.  The blue arrow shows you are set up to create a pdf. Select the 

spy glass by the red arrow.  Then toggle your way to the location you would like to save the pdf.  

(Typically in your plan sheet folder.)  If you would like to have the pdf open after it is created, select the 

box by the orange arrow. * See Tips and Tricks in Section 6 of this guide for File Naming Issues* 

 

To get a pdf and not several separate pdf’s, you NEED to make sure the Submit as is set as “Single print 

job”  (Black Arrow) 

 

 

 

 

Select Here: for 

a Paper Copy – 

See next page 

for directions. 
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Producing a Paper Copy 

 

Above is the box that pops up after you select the button “Printer Setup”.  Select the spy glass by the 

green arrow.  Then “Cancel” out of the Projectwise box. Your computer selection box opens.  

 

(At the top of the above screen print, it shows the location where the default Bentley printer config files 

are set up just in case your box does not open to this location, toggle through your c: drive and find this 

location.) 

Select the “printer. pltcfg” near the green arrow. Select “Open” 
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The box will change and give the option on the bottom to select any printer you have mapped to your 

computer.  Use the down arrow to make your selection.  

 

Select OK. Then Ok on the Original Print window.  The below screen shot shows the printer name and 

that it will be sent to the printer.  
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3. Creating a set that will Auto-Number and Name each sheet  
It is common practice to copy border sheets you will need for your project from the ITD Standards folder 

Borders . Copy these borders to your Project Resources folder under your Project >Project Development. 

You will use these borders to reference in to your plan sheets, therefore all the information can be filled 

out in the border, making this step a onetime step. If modifications are needed, you will only need to fix 

one border and all your plan sheets will be updated. In fact most of the information resides in the 

ProjectWise Attributes.  

Find your border drawing in ProjectWise. Right Mouse Click and go down to properties. This will open 

the document attributes. (SHORT CUT: select the document/drawing, push the space bar.  This too will 

open the document attributes.)  

Fill out all information. Overwrite/Delete the XXXXXX.  The SHEET TYPE is where the name of the sheet 

is.  This border is for Utility Plan Sheets.  The TITLE 1, 2 & 3 is where the name of your project goes.  

When the 3 lines are not needed, put the information in TITLE 2 so the words will be centered in the title 

block.  

 

 

pw:\\Itd-pw.bentley.com:Itd-pw-01\Documents\P{127e7ada-32f1-4f85-b7de-6087c8ad4f34}\
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To have your drawing name and your sheet no’s auto fill it is important to fill in the following: 

CADD FILE NAME type $FILES$ (Blue Arrow) 

SHEET NO. Type $P$ (Red Arrow) 

SHEETE NO. OF type $PG$ (Green Arrow) 

Close when completed. Then open up your border drawing. You will now place a title block cell.  In 

MicroStation, on the top menu select Element>Cells  

 

In this window that pops up, go to File>Attach File. Toggle through the Projectwise window to 

Workspace>ITD SS4>Microstation>Cell 

  

In the “Cell” folder find the “ITD_TitileBlock.cel”. Select it and “Open”. 
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Now your text should be the correct size and ready to be placed. You will need to “SNAP” to the bottom 

of the left hand corner of the plan sheet (not the cut border). 

 

Your Cell is now attached.  Next you must update to view the attribute you filled out in ProjectWise. 

Select “Utilities” from the top MicroStation menu. Then “Key-in”.  

In the Key-in type “titleblock updatenow”   and Enter

 

  

If it is colored, it is “on”.   

Select  to turn it off.  

Once this is open, you will 

see many cell choices in the 

Cell Library window.  Double 

click on the cell you would 

like to place.  That cell is now 

attached to your pointer in 

MicroStation.  You may see 

that the text is SUPER big. 

Find the window that popped 

up called “Place Active cell” 

Turn OFF the Annotation 

Lock.  
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4. Utilizing Custom Printing Styles 
 

 

 

 11x17 BW and 11x17 Color.  These Styles are self-explanatory.  These are the Styles that will be 

used the most.   

 

 11x17 ROW. Use this Style when you are needing to print Right of Way drawings.  Everything 

will be Black/White except anything on the following levels: 

o ROW_PARCEL 

o ROW_Total-Ownership-Boundary 

o ROW_Easement-Hatch 

 

 11x17 TRAFFIC.  Use this Style when you are needing to print plans with traffic signs.  This will 

print WITHOUT the fill on the signs.  This will included Signs created from Cells or imported from 

Sign CADD.  These signs must be placed on the following levels.  

o TRAF_SIGN_Annotation 

o TRAF_SIGN_Existing 

o TRAF_SIGN_Portable 

o TRAF_SIGN_Post 

o TRAF_SIGN_Proposed 

 

This is with window 

that comes up when 

you are ready to 

select Print Styles. 

These Print Styles are 

custom and set up for 

particular use.   
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 11x17 UTILITY. Use this Style when you are needing to print Utility plans.  All referenced files 

will be gray, then everything in the drawing will be Black/White except anything on the 

following levels:   

o TOPO_ELEC_*     

o TOPO_GAS_* 

o TOPO_LIGHTING_* 

o TOPO_OIL_* 

o TOPO_SAN_* 

o TOPO_STORM_* 

o TOPO_TELE_* 

o TOPO_TV_* 

o TOPO_WTRUTIL_* 

o TRAF_ILLUMINATION_* 

o All levels that begin with UTIL_* (attributes will also be a weight 2) 

 

 8.5x11 BW and 8.5 11 Color.  These Styles will print like the 11x17 Styles except it is set up for 

the 8.5 x11 sheet size.  
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5. Creating a 3D pdf 
 

A 3D pdf is a great way to show others your Terrain Model or Corridor.   

In any Drawing open Print Organizer. Select the tool to “Add File”   

 

Select “Add” then toggle through the ProjectWise menu to find the drawing you need.  You can select 

your design drawing even though it is a 2D drawing.  If you created a Corridor in your design file, the 

Print Organizer will select all models and your 3D model will be show up.   
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After you have selected your drawing, Select “Manually Specified Options”.  

 

Go to your “Fence” tab at the top of the new window, then select “Fit to mater model and all reference 

files”. Then select “OK”. Then “OK” again in the “Create Print Definitions” window.  
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Depending on the size of your drawing this will take a few minutes. 

 

The above screen shot is what the print organizer loaded.  This is every model you have in your drawing. 

Select the ITD Default 3D.  This model is the one created when you created your corridor. Select and 

Right Mouse click then go to “Properties”. 

 

On the main tab select “Print to 3D.  Now select “OK” Now you can create your 3D pdf. Select your 3D 

Model, then select Print.  
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Select the “Spy Glass” to give it a destination. This is also where you give it a name.  You need to toggle 

through the ProjectWise menus. Also, if you want the pdf to open after it is created, check mark in the 

box.  The Print Organizer will show you it is processing.  
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There are several tools in BlueBeam and Adobe that can change your view. For example from Solid to 

Wireframe.  You can also rotate the view by clicking in the window holding down your left mouse key.   

If you have “Saved Views” in your model they come through to your pdf.  This is a good idea so the user 

can view particular areas you may have concerns with. (Plus it takes a good coordinated mouse hand to 

rotate the view to where you want.)  

If you created multiple views in MicroStation you can easily go through those views by selecting the pull 

down arrow at the top. (Near the Blue Arrow above)    
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6. Tips Tricks and Trouble Shooting 
 

How to manage a very large plot set:  If you have a very large plot set it does take a great amount of 

time to prepare for printing.  Sometimes it will not finish the entire set or will have an error.  Try 

producing it in sections or half at a time. You can split it and put the final pdf together using Blue Beam.  

Also try working on large plot sets in the morning when there is less workload on the system.  The 

system seems to slow as the day goes on.  

 

FILE NAMING ISSUES: Print Organizer does not override/replace the previous pdf.  You must delete the 

previous pdf or RENAME the pdf.  The process will error out. If you are saving to ProjectWise; just 

deleting the pdf and renaming it the same will also error out because of the copy that is created on your 

local drive.  As an alternative consider saving/creating the pdf on your desk top.  You will still need to 

delete the pdf with the same name, but until you get exactly what you want, this is quicker with the 

lower possibility of error.  After you are happy with your results, drag and drop into ProjectWise.  

 

If the Plot Organizer seems to be hanging or getting stuck on a particular drawing.  You can see what 

drawing it is stuck on during the process.  Try Un-attaching it and re-attaching will usually fix it.  

 

If you need to change properties to multiple drawings in “Print Organizer”.  Select all that need the 

change.  Right Click, Select Properties.  Make the changes, then select “OK”.  All selected drawings have 

been updated to with your change.  

 

If you have made changes in the drawing you are in and want those changes to be included in your new 

plot set, you will need to “update server copy”.  You will find this in MicroStation under “File”. (If your 

change is very small it may not recognize the change, be sure to check) 

 

If you are having problems getting your title sheet to print correctly; in your Print Organizer right mouse 

click in your title sheet, go to properties, then in the main tab check the “Rasterized” box.  

  

If you have renamed a drawing Print Organizer may not recognize the change.  For example pl_001 to 

pl_001a.  Try Un-attaching it and re-attaching will usually fix it. It will attempt to use the re-named .dgn 

in the list but it will not be able to update the “name” column in print organizer. If you change a file 

name, be sure you are looking at the “file name” column when checking if it grabbed the right file. 

Below is a screen shot of the error and an example of the file name vs name. 

 

If you notice your line styles change to a solid line in your prints then you will need to select your 

drawing in your plot set, Right Mouse click, pick the Display tab and un-check “Level overrides”. This has 

been fixed and will work correctly with any new drawings created.  
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Note that when this happens, it looks like it grabbed the right dgn’s but it did not update the “Name” in 

the print organizer list. This can cause confusion. The “File Name” field is what it is based on the .dgn but 

the “Name” field is editable by the user so it doesn’t update the user defined name when the cad name 

changes. See below: 
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In a 3D pdf, if your view is long and skinny, you may need to go back to the properties in Print Organizer 

and change the Print area.  (This is on the Main tab.) Below is an example of what you DO NOT want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If an update to this guide needs done, Contact Kathy Buffat District 5 

Manual Date 3/2019 
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7. Default Properties 
The following are screen shots of the Print Styles Properties.   

 

 

This Main tab is really the only place you will find a difference in the default set ups.  The pen table will 

always be the “ITD.tbl” But the Design script will show the style that is selected for that drawing.  This 

one is the “Halfsize BW.pen”.  If you decided you want this color, select the spyglass to change it.  
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Below is the default window if you right click and select “print” 

 



ITD VICINITY MAP 

 

Go to the IPLAN app on the ITD website. http://iplan.maps.arcgis.com/home/index.html 

• Use the General ITD Information app for the maps. 

http://iplan.maps.arcgis.com/home/index.html


 

Setting up the vicinity map 

• Set up the layers you would like to see on the map (i.e. Mile Point Layers, BLM PLSS 

Layers (township/range)). 

• Basemap gallery, use “National Geographic” 

• Pick print 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



• If you pick one of the layouts that have the word Project on the end, you will get this 

layout from the Advanced button. 

 

 

 

 

 

 

 

 

 

 

 

This would be great for the environmental maps.  This information will be placed in the lower 

right corner of the PDF. 

Printing to a pdf (color) 

• Pick the print icon at the bottom then pick Advanced and setup the print options shown in 

the screen shot.  Lots of options that we will need to look into. 

• Set the print quality higher than 330 it may crash. 

• After setting the print options Pick Print. 

 

 

 

 

 

• After it creates a PDF pick the file. 

• After the PDF opens make sure you like what you see 

• Then pick File then Save as in the upper left corner and put it on your Desktop. 

• Then drag it into your ProjectWise folder. 

• You can print it if you like 



 

Printing to a pdf (black/white) 

• To get a black and white use the settings shown in the screen shot. 

 

1. Create a CADD file to reference in the PDF 

2. Open the CADD file 

3. Open the Raster Manager 

4. Pick File, then Attach, then Raster 

5. Navigate to the folder you copied the map too. 

6. Pick it then pick OK 

7.  

 

 

 

 

 

 



8. Under Place Interactively leave it at No 

9. Open the Reference box and pick Tools then Attach 

10. Navigate to the folder you copied the border too. 

11. Pick it then pick OK 

12.  

 

 

 

 

 

 

 

 

13. Now place it over the Map 

14. Now place a fence around the map you want to keep 

15. Pick the raster in the Raster Manager 

16. Then pick Edit and then Clip 

17. In the tool setting box make sure the Method is set to Fence and the Mode is set to Clip 

Boundary 

18. Then do a Data Button (Left Button) in the screen 

19. Then hold down the Reset Button (Right Button) until a menu pops up then pick Turn 

Level Off By element. 

20. Then pick the line along the right side. 

21. Now place your project note 

22. If you need to place a fence around your note 15, 16, and 17 but under Mode set it to Clip 

Mask 
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